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About i-access Kiosk
The i-access Kiosk software (Kiosk) allows you to download titles from your Vision Australia Library online bookshelf to your Envoy Connect player or computer.
To use Kiosk you have to be a registered member of the Vision Australia Library and have a Username and Password.
If you are not a member, please contact the Vision Australia Library on 1300 654 656, or email: library@visionaustralia.org
i-access Kiosk is designed for Microsoft Windows 10.
For Kiosk to work, the computer must be connected to the internet.
[bookmark: _Toc105402286][bookmark: _Toc18311445][bookmark: _Toc18316744][bookmark: _Toc19278059]How to Install
There are two methods of installing the Kiosk software:
· Directly from the Envoy Connect player
· Downloading from Vision Australia
[bookmark: _Toc105402287]Installing from the Player
The i-access Kiosk software can be found in the SYSTEM folder on the Envoy Connect player.  The installation file is called KioskSetup.exe.
To install the software, ensure the player is switched off, then plug it into the computer using the supplied USB data cable.  The player will emit a chime to confirm the connection.
Note that Windows File Explorer may open automatically when you connect the player.
The player is called CONNECT in File Explorer.  Open this to view the SYSTEM folder on the player.
Within the SYSTEM folder, there is a folder called ‘i-access Kiosk’.  The Kiosk software is in this folder.
Select the ‘KioskSetup.exe’ file to begin installation.
During installation, you may be presented with a ‘Microsoft Windows Security’ message asking if you want to install the software.  Select the ‘Install’ button. 
An ‘i-access Kiosk’ shortcut (icon) will be placed on your desktop when the installation is finished.  
[bookmark: _Toc105402288]Installing from the Website
The i-access Kiosk software can be downloaded from: http://softwareupdate.i-accessonline.visionaustralia.org/iaccesskiosk/KioskSetup.exe 
Once the Kiosk software has finished downloading to the Downloads folder on your computer, select the ‘KioskSetup.exe’ file to begin installation.
During installation, you may be presented with a ‘Microsoft Windows Security’ message asking if you want to install the software.  Select the ‘Install’ button. 
An ‘i-access Kiosk’ shortcut (icon) will be placed on your desktop when the installation is finished.
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There are two main modes of operation for the Kiosk software:
· Envoy Connect mode (Download to an Envoy Connect player)
· Local Computer mode (Download to the Computer)
The Envoy Connect mode is the default mode.
The alternate modes are described in the ‘Kiosk Options’ section below.
Note that when you run Kiosk, the title bar displays the current Kiosk mode (Envoy Connect or Local Computer).
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Envoy Connect Manual mode is the default mode.  It allows you to choose titles to remove from the Envoy Connect player and choose new titles to download from your online Library bookshelf onto the player.
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Ensure your player is switched off, then connect it to the computer using the supplied USB data cable.  The player will emit a chime to confirm the connection.
Note that if Kiosk is running before plugging in the player, it will prompt you to plug it in.
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To run i-access Kiosk, use the i-access Kiosk icon on your computer desktop.
When you first run Kiosk a ‘Getting Started’ guide will appear.
You can choose not to display the Getting Started guide when you run Kiosk by deselecting the ‘Show next time on Startup’ checkbox.  You can access Getting Started and this User Guide at any time from the Help menu.
Select the ‘Close’ button to proceed.
A message will confirm that a player is plugged in.
Select the ‘Continue’ button to proceed or the ‘Cancel’ button to return to the main screen.
To login to the Library from the main screen, select the 'Connect to Library' button.
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If your player is registered with the Library, the player will be recognised by the system and login automatically.
If your player is not registered, you will be prompted to enter your Library Username and Password.
‘Tick’ the ‘Save Username/Password’ checkbox to avoid entering it each time.  If your login fails for any reason, the login screen reappears.
Select the ‘OK’ button to proceed.
Kiosk will connect to the Vision Australia online Library.
Note that logging in may take a few minutes depending on the size of your online bookshelf and the speed of your internet connection.  Do not unplug your player.
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If there is a message from the Library, a ‘popup’ window will appear during login.  Select the ‘Close’ button to retain the message or select the ‘Delete’ button if you do not wish to read it again.
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When logging in to the Library and downloading, a status field always shows the progress.  This window also shows the Username and the player serial number.
Select the ‘Cancel’ button if you want to stop the process at any time and return to the main screen.
Note that if you cancel downloading, only those titles that have completed downloading will be playable on the player.  When you next run Kiosk, you will need to reselect the titles from your bookshelf to resume downloading them.
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Once Kiosk has logged on, Kiosk will display the ‘Select Titles to Remove’ window.
This is the list of titles on your Envoy Connect player.
Select one or more titles from the list to remove them from your player.  This will also remove them from your online bookshelf.
Removing titles will allow more titles to be added to your online bookshelf to replace those that you remove.
You can also use the ‘Select All’ or ‘Deselect All’ buttons.
Note that you do not need to remove any titles, however, eventually the memory on the player will become full preventing you from downloading more titles.
Select the ‘Next’ button to proceed.
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Kiosk will display the ‘Select Titles to Download’ window.
This is the list of titles on your online Library bookshelf that you can download.
Select one or more titles from the list to download to your player.
You can also use the ‘Select All’ or ‘Deselect All’ buttons.
Note that if this list is empty, your new titles are being prepared in the background.  Populating your bookshelf may take up to an hour.  Continue to the next step and check the list again later.
Select the ‘Next’ button to proceed, or the ‘Back’ button to return to the previous screen.
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Kiosk will ask you to confirm the selections you have made in the previous windows.
Select the ‘Next’ button to proceed with the content update (removing and downloading).
If you wish to review or change your selections, select the ‘Back’ button. 
Note that if you use the ‘Back’ button you will need to reselect any titles you had previously selected.
You can select the ‘Cancel’ button if you want to ignore all previous steps and return to the main screen.
Note that downloading content onto your player may take some time depending on how many titles you have selected and the speed of your internet connection.
Once the downloading of content commences, the Status field will keep you informed of progress.
Do not disconnect the player or exit the program until Kiosk confirms “Your content has been updated”.
[bookmark: _Toc105402299]Update Completed
The ‘Content Updated’ confirmation message will be displayed once the download of content has finished.
It is now safe to disconnect the player.  Note that it is always good practice to use the Windows USB Eject feature when removing USB devices.
Select the ‘OK’ button to return to the main screen of Kiosk.  Select the ‘Exit’ button to close the Kiosk software.
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The instructions for Local Computer mode are the same as Envoy Connect Manual mode, except that the content is downloaded to your local computer instead of to your Envoy Connect.
To select this option, go to the File Menu (see File Menu section below).
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Important Note: Only use Automatic mode after you understand how it works as described below.
Envoy Connect Automatic mode always removes all content from your Library bookshelf as well as your player.  It also downloads all of the new titles from your bookshelf onto the player without user input or confirmation.
Be sure you wish to always automatically remove all content from your player and bookshelf before selecting this mode.
[bookmark: _Toc105402302]To select this option, go to the File Menu (see File Menu section below).
Login
The instructions for logging on and monitoring progress are the same as Manual mode.
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In Automatic mode, as soon as you log in, all content is immediately removed from the player and also from your online bookshelf.
Once all titles are removed, new titles will be added to your online bookshelf in the background.  Populating your bookshelf may take up to an hour.
Kiosk will ask you to wait for an hour before continuing.  Select the ‘OK’ button to return to the main screen of Kiosk while you wait.
Note that if this is the first time you are connecting a new player, there are no titles on the player to remove.  Kiosk will immediately begin to download the current bookshelf.
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After waiting for up to an hour, run Kiosk with the player plugged in.
Downloading will begin automatically and the Status field will keep you informed of progress.
Do not select the ‘Cancel’ button, disconnect the player or exit the program until Kiosk confirms “Your content has been updated”.  Interrupting the download will result in the removal of titles that have only partially downloaded and Kiosk cannot re-download them.
When the ‘Content Updated’ confirmation message appears, select the ‘OK’ button to return to the main screen of Kiosk.  Select the ‘Exit’ button to close the Kiosk software.
It is now safe to disconnect the player.  Note that it is always good practice to use the Windows USB Eject feature when removing USB devices.
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In Automatic mode, a new list of titles is generated on the bookshelf every time a player is connected.  This allows a person to use two Envoy Connect players, each with a different list of titles.
For example, a user can listen to one player while a family member or friend is loading the second player.
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When you select Local Computer mode, a new folder called ‘i-access Kiosk Content’ is placed on your computer desktop.  This is where all downloaded titles are saved in Local Computer mode.
Note that depending on your computer settings, this folder may contain a file called ‘_bookshelf.xml’.  Do not move or delete it.  Doing so may affect the content update process.
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This window allows you to connect to the Library and start the content download process.  It also provides access to your ‘MyVA’ website, desktop content folder, as well as the File and Help menus.
Select the 'Connect to Library' button to connect to the Vision Australia Library, view your online bookshelf and update content on your player or computer.
Select the ‘My VA Website’ button to access your Library account.  The website will open in a separate window.  Using the MyVA website, you can set user preferences as well as search and add titles to your bookshelf.
Select the ‘Exit’ button to close the Kiosk software.
Note that the Kiosk title bar displays the current mode (Envoy Connect or Local Computer).
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You can select two main devices to be used by Kiosk.
· Envoy Connect Player
· Local Computer
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Select this option to download from your online Library bookshelf onto your Envoy Connect player.
This is the default option when you install Kiosk.
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Select this option to download from your online Library bookshelf onto your computer.
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There are two loading modes when you choose to load to an Envoy Connect player.
· Manual
· Automatic
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This option allows you to choose new titles to download from your Library bookshelf onto your player, and titles you would like to remove from the player.
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This option automatically updates the player without any user input or confirmation.
It immediately removes all titles from the player and online Library bookshelf, generates a new list of titles and downloads all new titles from your bookshelf onto the player.
Automatic mode allows use of two Envoy Connect players, each with a different list of titles.
Use this mode with caution.  Any time you connect your player, all content will be removed from both your player and your online bookshelf.  Kiosk cannot re-download titles once they are removed.
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You can choose to display or not display the Getting Started guide each time you run Kiosk by using the ‘Show Getting Started on Startup’ checkbox.
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If you previously chose to save your username and password when logging in, you can select the ‘Clear Saved Username and Password’ button so that you are prompted to enter them again when you next run Kiosk.
This is useful if your Kiosk is to be used by someone else to prevent them logging into your account.
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The ‘Use default location in Local Computer mode’ checkbox is selected by default.  This saves downloaded titles to the ‘i-access Kiosk Content’ folder on your computer desktop.
You can choose a different location by ‘unticking’ the checkbox and selecting ‘Browse’.  This opens a ‘Browse’ window where you can choose a different location or create a new folder by using the ‘Make New Folder’ button.  Select the ‘OK’ button to save your preferred location.  Use the 'Cancel’ button to return to the Options menu without saving your changes.
The ‘Content Location’ field displays the file path.
Note: when choosing a different folder location, be sure not to choose the CONNECT drive.  This drive is the Envoy Connect player.
If you wish to download to the player, choose Envoy Connect Mode from the Options menu.
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After you set your preferences, select the ‘OK’ button to save your changes and return to the main screen.
Note that Kiosk will remember the currently selected settings each time you run the software.
Select the ‘Cancel’ button to return to the main screen without saving your changes.
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This opens the ‘i-access Kiosk Content’ folder from your desktop in a separate File Explorer window.
Within this folder there is another folder called Downloads.  This is where all downloaded titles are saved in Local Computer mode.
Note that this menu item is only visible if you are using Local Computer Mode.
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This opens the Vision Australia ‘MyVA’ website in a separate window.  Here you can access your Library account to set user preferences as well as search and add titles to your bookshelf.
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Select Exit to close i-access Kiosk.
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Opens the ‘Getting Started’ guide.
You can choose if the Getting Started guide is displayed when you run Kiosk by selecting or deselecting the ‘Show next time on Startup’ checkbox.
Select the ‘Close’ button to return to the main screen.
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Opens the ‘User Guide’.
Select the ‘Close’ button to return to the main screen.
[bookmark: _Toc105402326]About
Information about i-access Kiosk, including the version number and Vision Australia contact details.
Select the ‘OK’ button to return to the main screen.
[bookmark: _Toc105402327]New Versions of i-access Kiosk
Each time you run i-access Kiosk, it checks if a newer version is available.  If a software update is available, it will automatically update.
When a software update occurs, a progress status screen will momentarily appear.  You do not need to do anything.  When the software update is finished, Kiosk will open as normal.
If a software update has occurred, the ‘Getting Started’ guide will be displayed and describe ‘What’s New’ in the latest version of i-access Kiosk.
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We want your experience using i-access Kiosk to be the best possible.  If you have any questions or comments, please contact the Vision Australia Library on 1300 654 656 or email: library@visionaustralia.org 
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